
    ADuCM4050 EZ-KIT    ®Manual 

  

Revision 1.0, December 2016

Part Number
82-000802-01

Analog Devices, Inc.
One Technology Way
Norwood, MA 02062-9106



Copyright Information

© 2016 Analog Devices, Inc., ALL RIGHTS RESERVED. This document may not be reproduced in any form
without prior, express written consent from Analog Devices, Inc.

Disclaimer

Analog Devices, Inc. reserves the right to change this product without prior notice. Information furnished by Ana-
log Devices is believed to be accurate and reliable. However, no responsibility is assumed by Analog Devices for its
use; nor for any infringement of patents or other rights of third parties which may result from its use. No license is
granted by implication or otherwise under the patent rights of Analog Devices, Inc.

Trademark and Service Mark Notice

The Analog Devices logo, Blackfin, Blackfin+, SHARC, SHARC+, CrossCore, VisualDSP++, EZ-KIT, EZ-Extend-
er, and EngineerZone are registered trademarks of Analog Devices, Inc.

All other brand and product names are trademarks or service marks of their respective owners.

Regulatory Compliance

The ADuCM4050 EZ-KIT is designed to be used solely in a laboratory environment. The board is not intended for
use as a consumer-end product or as a portion of a consumer-end product. The board is an open system design,
which does not include a shielded enclosure and, therefore, may cause interference to other electrical devices in close
proximity. This board should not be used in or near any medical equipment or RF devices.

The ADuCM4050 EZ-KIT is in the process of being certified to comply with the essential requirements of the Euro-
pean EMC directive 2004/108/EC and, therefore, carries the “CE” mark.

ADuCM4050 EZ-KIT ®Manual ii



The ADuCM4050 EZ-KIT contains ESD (electrostatic discharge) sensitive devices. Electrostatic charges readily accu-
mulate on the human body and equipment and can discharge without detection. Permanent damage may occur on
devices subjected to high-energy discharges. Proper ESD precautions are recommended to avoid performance degra-
dation or loss of functionality. Store unused boards in the protective shipping package.
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1   Preface

Thank you for purchasing the Analog Devices, Inc. ADuCM4050 EZ-KIT evaluation system.

The ADuCM4050 processor is an ultra low-power integrated mixed-signal microcontroller system for processing,
control and connectivity. The MCU system is based on the ARM Cortex-M4F processor. The MCU also has a col-
lection of digital peripherals, embedded SRAM and flash memory, and an analog subsystem which provides clock-
ing, reset, and power management capability in addition to an ADC subsystem.

The EZ-KIT contains an array of three connectors that support the ADF7xxx Wireless Transceiver series of daugh-
terboard products. Refer to ADF7xxx Wireless Transceiver Daughterboard Interface for more information.

The EZ-KIT contains Expansion Interface 3 (EI3) and Arduino interfaces. These interfaces provide connections for
daughterboards to expand the functionality of the EZ-KIT. Refer to Expansion Interface 3 and Arduino Interface for
more information

The evaluation board is designed to be used in conjunction with the IAR Embedded Workbench®, Keil®, Cross-

Core® Embedded Studio and Segger® development environments for advanced application code development and
debug, such as:

• Create, compile, assemble, and link application programs written in C++, C, and assembly

• Load, run, step, halt, and set breakpoints in application programs

• Read and write data and program memory

• Read and write core and peripheral registers

This manual will demonstrate the use of IAR Embedded Workbench® and Segger® tools. Please refer to BSP User

Guide for CrossCore®Embedded and other development environments.

Purpose of This Manual
This manual provides instructions for installing the product hardware (board). This manual describes operation and
configuration of the board components and provides guidelines for running code on the board.

This manual is applicable for both ADuCM4050 LFCSP (ADZS-U4050LF-EZKIT) and ADuCM4050 WLCSP
(ADZS-U4050WL-EZKIT) EZ-KIT. Differences have been shown throughout in the manual wherever applicable.

Preface
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Intended Audience
The primary audience for this manual is a programmer who is familiar with an ARM Cortex-M4 core. The
ADuCM4050 family of processors is based on the ARM Cortex-M4 core.

For additional information about the Analog Devices processor, see the Hardware Reference Manual. The document
describes the core and memory architecture of the ADuCM4050 processor, but does not provide detailed program-
ming information.

The applicable documentation for programming the ARM Cortex-M4 core includes:

• Cortex-M4 Devices Generic User Guide

• CoreSight ETM-M4 Technical Reference Manual

• Cortex-M4 Technical Reference Manual

For more information about programming the ARM core, visit the ARM Information Center:

http://infocenter.arm.com/help/

Manual Contents
The manual consists of:

• Using the board

Provides basic board information.

• Hardware Reference

Provides information about the hardware aspects of the board.

• Bill of Materials

A companion file in PDF format that lists all of the components used on the board is available in the installa-
tion directory for the Board Support Package (BSP) and on http://www.analog.com/ADuCM4050 .

• Schematic

A companion file in PDF format documenting all of the circuits used on the board is available in the installa-
tion directory for the Board Support Package (BSP) and on http://www.analog.com/ADuCM4050 .

Technical Support
You can reach Analog Devices processors and DSP technical support in the following ways:

• Post your questions in the processors and DSP support community at EngineerZone®:

http://ez.analog.com/community/dsp

• Submit your questions to technical support directly at:

Intended Audience
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http://www.analog.com/support

• E-mail your questions about processors, DSPs, and tools development software from CrossCore Embedded Stu-
dio® or VisualDSP++®:

If using CrossCore Embedded Studio or VisualDSP++ choose Help > Email Support. This creates an e-mail to
processor.tools.support@analog.com and automatically attaches your CrossCore Embedded Studio or Visu-
alDSP++ version information and license.dat file.

• E-mail your questions about processors and processor applications to:

processor.tools.support@analog.com

processor.china@analog.com

• Contact your Analog Devices sales office or authorized distributor. Locate one at:

http://www.analog.com/adi-sales

• Send questions by mail to:

Analog Devices, Inc.

One Technology Way

P.O. Box 9106

Norwood, MA 02062-9106

USA

Supported Processors
This evaluation system supports the Analog Devices ADuCM4050 processor.

Supported Tools
Information about code development tools for the ADuCM4050 EZ-KIT and ADuCM4050 family of processors is
available at:

http://www.analog.com/ADuCM4050

Product Information
Product information can be obtained from the Analog Devices Website

Analog Devices Website

The Analog Devices website, http://www.analog.com, provides information about a broad range of products - ana-
log integrated circuits, amplifiers, converters, and digital signal processors.

Supported Processors
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To access a complete technical library for each processor family, go to http://www.analog.com/processors/techni-
cal_library. The manuals selection opens a list of current manuals related to the product as well as a link to the
previous revisions of the manuals. When locating your manual title, note a possible errata check mark next to the
title that leads to the current correction report against the manual.

Also note, MyAnalog.com is a free feature of the Analog Devices website that allows customization of a web page to
display only the latest information about products you are interested in. You can choose to receive weekly e-mail
notifications containing updates to the web pages that meet your interests, including documentation errata against
all manuals. MyAnalog.com provides access to books, application notes, data sheets, code examples, and more.

Visit MyAnalog.com to sign up. If you are a registered user, just log on. Your user name is your e-mail address.

EngineerZone

EngineerZone is a technical support forum from Analog Devices, Inc. It allows you direct access to ADI technical
support engineers. You can search FAQs and technical information to get quick answers to your embedded process-
ing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar design challenges. You can also use this
open forum to share knowledge and collaborate with the ADI support team and your peers. Visit http://
ez.analog.com to sign up.

Notation Conventions
Text conventions used in this manual are identified and described as follows. Additional conventions, which apply
only to specific chapters, may appear throughout this document.

Example Description

File > Close Titles in bold style indicate the location of an item within the CrossCore Embed-
ded Studio IDE’s menu system (for example, the Close command appears on the
File menu).

{this | that} Alternative required items in syntax descriptions appear within curly brackets and
separated by vertical bars; read the example as this or that. One or the other
is required.

[this | that] Optional items in syntax descriptions appear within brackets and separated by
vertical bars; read the example as an optional this or that.

[this, …] Optional item lists in syntax descriptions appear within brackets delimited by
commas and terminated with an ellipsis; read the example as an optional comma-
separated list of this.

.SECTION Commands, directives, keywords, and feature names are in text with letter
gothic font.

filename Non-keyword placeholders appear in text with letter gothic font and italic
style format.

Product Information
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Example Description

NOTE: NOTE: For correct operation, ..

A note provides supplementary information on a related topic. In the online ver-
sion of this book, the word NOTE: appears instead of this symbol.

CAUTION: CAUTION: Incorrect device operation may result if ..

CAUTION: Device damage may result if ..

A caution identifies conditions or inappropriate usage of the product that could
lead to undesirable results or product damage. In the online version of this book,
the word CAUTION: appears instead of this symbol.

ATTENTION: ATTENTION: Injury to device users may result if ..

A warning identifies conditions or inappropriate usage of the product that could
lead to conditions that are potentially hazardous for devices users. In the online
version of this book, the word ATTENTION: appears instead of this symbol.

Notation Conventions
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2   Using the Board

This chapter provides information on the major components and peripherals on the board along with instructions
for installing and setting up the emulation software.

Product Overview
The board features:

• Analog Devices ADuCM4050 processor

• 64-pin LFCSP package or 72-ball WLCSP package

• 26 MHz oscillator

• SPI Flash (SPI2) chip

• 32Mb

• Windbond W25Q32

• Accelerometer (SPI2)

• Analog Devices ADXL363

• Temp sensor (I2C)
• Analog Devices ADT7420

• Universal Asynchronous Receiver/Transmitter (UART0)

• FTDI FT232R USB to UART IC

• USB mini-B

• Debug (SWD/SWO) interface

• J-Link Lite ARM debugger

• SWD/SWO 20-pin 0.1” header for use with IAR emulators

• SWD/SWO 10-pin 0.05” header

Using the Board
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• LEDs

• Six LEDs: one power (green), one mbed (amber), one board reset (red), and three general-purpose (am-
ber)

• One RGB LED

• Pushbuttons

• Five pushbuttons: one reset, one wake, one boot and two IRQ/Flag

• Expansion Interface 3 (EI3) connector

• CLKOUT

• SPORT0

• SPI1

• I2C

• UART0

• TWI0

• Timers

• GPIOs

• RESET

• GND/3.3V/5V output

• Arduino Interface

• mbed Interface

• ADF7xxx Wireless Transceiver Daughterboard Interface

• External power supply input (optional)

• CE compliant

• 5V @ 3.6 Amps

• Power measurement

• Jumpers for measuring processor and board current draw

Package Contents
Your ADuCM4050 EZ-KIT package contains the following items.

• ADuCM4050 EZ-KIT (LFCSP/WLCSP) board

Package Contents
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• USB 2.0 Cable (For Power and USB communication)

• J-Link Lite Emulator Package

• J-Link Lite emulator

• 20 Pin flat cable

• USB 2.0 Cable

Contact the vendor where you purchased your ADuCM4050 EZ-KIT or contact Analog Devices, Inc. if any item is
missing.

Default Configuration
The ADuCM4050 EZ-KIT board is designed to run as a standalone unit.

The Default Hardware Setup figure shows the default settings for jumpers and switches and the location of the
jumpers, switches, connectors, and LEDs. Confirm that your board is in the default configuration before using the
board.

Default Configuration
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Figure 2-1: Default Hardware Setup for ADuCM4050 WLCSP EZ-KIT

Default Configuration

2–4 ADuCM4050 EZ-KIT ®Manual



J8

P12
P9

J9

P1

P3

P2

P8

P10

P6P11
P4

J5

P5

J4

J3

P1AJ1

J2

J6J7

LE
D

1

LE
D

5

LE
D

3

LE
D

4

LED7

LED6

LE
D

2

JP4

JP17

JP3

JP2

JP15
JP14JP16

JP10

JP6JP11

JP12

JP9

JP18 JP7

JP1

JP8

SW2 SW3

SW5

SW1

SW4

JP5 JP19

JP13

2

3

4

2

3

4

2

9

10

2

19

20

2

9

10

2

9

10

2

19 20

2

7

8 2

19

20

2

9

10

2

910

2

119 120

2

56

2

5

6

28

7

Figure 2-2: Default Hardware Setup for ADuCM4050 LFCSP EZ-KIT

NOTE: Connectors on the back of the board are noted with dotted lines.

IAR Embedded WorkBench Setup
For information about the IAR Embedded Workbench® and Segger® product and software download, go to:

http://www.iar.com/en/Products/IAR-Embedded-Workbench.

The ADuCM4050 EZ-KIT software, based on the IAR Embedded WorkBench, can be found at:

http://www.analog.com/ADuCM4050

Follow these instructions to ensure correct operation of the product software and hardware.

1. Connect the EZ-KIT board to a personal computer (PC) running IAR Embedded WorkBench, using a J-
Link/J-Trace emulator package:

IAR Embedded WorkBench Setup
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a. Plug one side of the USB cable into the USB connector of the emulator. Plug the other side into a USB
port of the PC running IAR Embedded WorkBench.

b. Attach the emulator to the header connector, P4 or P5 on the EZ-KIT board.

2. Plug one end of USB cable into the USB connector P6 of EZ-KIT and other end into USB Port of PC. Power
LED ( LED2 ) will illuminate green light once the USB cable connection is complete.

It is assumed that the IAR Embedded WorkBench software is installed and running on your PC.

1. Navigate to the IAR Embedded WorkBench environment via the Start menu.

2. Choose File > Open > Workspace to open a workspace for the project to download and debug.

3. Choose Project > Options.

The General Options, Target page appears.

4. In Processor variant, ensure Device is Analog Devices ADuCM4x50

5. Choose Debugger in the Category pane.

The Debugger, Setup options page appears.

a. In Driver, choose J-Link/J-Trace as the emulator to be used to debug the target board.

b. Click the Download tab. The Debugger, Download options page appears.

c. Ensure Use flash loader(s) is enabled. Note that other download settings are optional.

6. Choose Debugger > J-Link/J-Trace in the Category pane.

The emulator Setup options page appears.

a. On the Setup page,

• In Reset, select Connect during reset from the drop-down list.

• In JTAG/SWD speed, select Auto.

• (Optional) In Clock setup, change the default values.

b. On the Connection page,

• In Communication, select USB and Device 0.

• In Interface, select SWD.

7. Click OK to save the emulator settings.

8. Choose Project > Debug and Download to download the project and start debugging.

mbed Interface
Support for mbed will be provided in a future BSP release.

mbed Interface
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Debug Interface
The ADuCM4050 EZ-KIT provides a SWD/SWO connection via P4 or P5.

Power-On-Self Test
The Power-On-Self-Test Program (POST) tests all EZ-KIT peripherals and validates functionality as well as connec-
tivity to the processor. Once assembled, each EZ-KIT is fully tested for an extended period of time with POST. All
EZ-KIT boards are shipped with POST preloaded into flash memory. The POST is executed by resetting the board
and pressing the proper push button(s). The POST also can be used as a reference for a custom software design or
hardware troubleshooting.

Note that the source code for the POST program is included in the Board Support Package (BSP) along with the
readme file that describes how the board is configured to run POST.

Power Measurements
Locations are provided for measuring the current draw from various power planes. Jumpers are available on the
MAIN_3V and PROC_3V voltage domains. For current draw, the jumper is removed and a precision ammeter in-
serted in series. The board allows for measuring the current draw of just the processor by removing the jumper on
pins 1 and 3 and inserting an ammeter. Current draw can be measured in all operating modes of the processor.

Refer to Current Measurement ( JP1-3,JP15 ) section for more details.

Example Programs
Example programs are provided with the ADuCM4050 EZ-KIT Board Support Package (BSP) to demonstrate vari-
ous capabilities of the product. The programs can be found in the ADuCM4050_EZ-KIT\examples installa-
tion folder. Refer to the readme file provided with each example for more information.

Reference Design Information
A reference design info package is available for download on the Analog Devices Web site. The package provides
information on the schematic design, layout, fabrication, and assembly of the board.

The information can be found at:

http://www.analog.com/ADuCM4050

32M-bit Serial Flash Memory with Dual and Quad SPI
(W25Q32)
The W25Q32BV (32 Mb) Serial Flash memory provides a storage solution for systems with limited space, pins and
power. The 25Q series offers flexibility and performance well beyond ordinary Serial Flash devices. They are ideal

Debug Interface
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for code shadowing to RAM, executing code directly from Dual/Quad SPI (XIP) and storing voice, text and data.
The device operates on a single 2.7V to 3.6V power supply with current consumption as low as 4 mA active and 1
uA for power-down.

The W25Q32BV array is organized into 16,384 programmable pages of 256 bytes each. Up to 256 bytes can be
programmed at a time. Pages can be erased in a group of 16 (4 KB sector erase), groups of 128 (32 KB block erase),
groups of 256 (64 KB block erase) or the entire chip (chip erase). The W25Q32BV has 1024 erasable sectors and 64
erase blocks respectively. The small 4 KB sectors allow for greater flexibility in applications that require data and
parameter storage.

The W25Q32BV supports the standard Serial Peripheral Interface (SPI), and a high performance Dual/Quad out-
put as well as Dual/Quad I/O SPI: Serial Clock, Chip Select, Serial Data I/O0 (DI), I/O1 (DO), I/O2 (WP), and
I/O3 (/HOLD). SPI clock frequencies of up to 104 MHz are supported, providing equivalent clock rates of 208
MHz (104 MHz x 2) for Dual I/O and 320 MHz (80 MHz x 4) for Quad I/O when using Fast Read Dual/Quad
I/O instructions. These transfer rates can outperform standard Asynchronous 8 and 16-bit Parallel Flash memories.
The Continuous Read Mode allows for efficient memory access with as few as 8-clocks of instruction-overhead to
read a 24-bit address, allowing true XIP (execute in place) operation.

16-Bit Digital I2C Temperature Sensor (ADT7420)
The ADT7420 is a high-accuracy digital-temperature sensor offering breakthrough performance over a wide indus-
trial range, housed in a 4 mm × 4 mm LFCSP package. It contains an internal band gap reference, a temperature
sensor, and a 16-bit ADC to monitor and digitize the temperature to 0.0078°C resolution. The ADC resolution, by
default, is set to 13 bits (0.0625°C). The ADC resolution is a user-programmable mode that can be changed
through the serial interface.

The ADT7420 is guaranteed to operate over supply voltages from 2.7V to 5.5V. Operating at 3.3V, the average
supply current is typically 210 μA. The ADT7420 has a shutdown mode that powers down the device and offers a
shutdown current of typically 2.0 μA at 3.3V. The ADT7420 is rated for operation over the -40°C to +150°C tem-
perature range.

Pins A0 and A1 are available for address selection, giving the ADT7420 four possible I2C addresses. The CT pin is
an open-drain output that becomes active when the temperature exceeds a programmable critical temperature limit.
The INT pin is also an open-drain output that becomes active when the temperature exceeds a programmable limit.
The INT pin and CT pin can operate in comparator and interrupt event modes.

Micropower 3-Sensor Combination Including Acceleration
and Temperature (ADXL363)
The ADXL363 is an ultralow power, three-sensor combination consisting of a 3-axis MEMS accelerometer, a tem-
perature sensor, and an on-board ADC input for synchronous conversion of an external signal. The entire system
consumes less than 2 μA at a 100 Hz output data rate and 270 nA when in motion triggered wake-up mode.

16-Bit Digital I2C Temperature Sensor (ADT7420)
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The ADXL363 communicates via a serial port interface (SPI) and always provides 12-bit output resolution for all
three sensors.

The ADXL363 accelerometer provides selectable measurement ranges of ±2 g, ±4 g, and ±8 g, with a resolution of 1
mg/LSB on the ±2 g range. Unlike accelerometers that use power duty cycling to achieve low power consumption,
the ADXL363 does not alias input signals by undersampling; it samples the full bandwidth of the sensor at all data
rates.

The ADXL363 temperature sensor operates with a scale factor of 0.065°C (typical). Acceleration and temperature
data can be stored in a 512-sample multimode FIFO buffer, allowing up to 13 sec of data to be stored.

In addition to the accelerometer and temperature sensor, the ADXL363 also provides access to an internal ADC for
synchronous conversion of an additional analog input.

The ADXL363 operates on a wide 1.6V to 3.5V supply range and can interface, if necessary, to a host operating on
a separate, lower supply voltage.

USB to UART (FT232R)
The FT232R is a USB-to-serial-UART interface with the following advanced features:

• Single chip USB to asynchronous serial data transfer interface

• Entire USB protocol handled on the chip. No USB specific firmware programming required

• Fully-integrated 1024 bit EEPROM storing device descriptors and CBUS I/O configuration

• Fully-integrated USB termination resistors

• Fully-integrated clock generation with no external crystal required, plus optional clock output selection ena-
bling a glue-less interface to external MCU or FPGA

• Data transfer rates from 300 baud to 3 Mbaud (RS422, RS485, RS232) at TTL levels

• 128 byte receive buffer and 256 byte transmit buffer utilizing buffer smoothing technology to allow for high-
data throughput

• FTDI’s royalty-free Virtual Com Port (VCP) and Direct (D2XX) drivers eliminate the requirement for USB
driver development in most cases.

• Transmit and receive LED drive signals

• UART interface support for 7 or 8 data bits, 1 or 2 stop bits and odd / even / mark / space / no parity

• FIFO receives and transmits buffers for high-data throughput

• Device supplied pre-programmed with unique USB serial number

• Supports bus powered, self-powered and high-power bus powered USB configurations

• Integrated +3.3V level converter for USB I/O

USB to UART (FT232R)
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• Integrated level converter on UART and CBUS for interfacing to between +1.8V and +5V logic

• True 5V/3.3V/2.8V/1.8V CMOS drive output and TTL input

• Configurable I/O pin output drive strength

• Integrated power-on-reset circuit

• Fully-integrated AVCC supply filtering - no external filtering required.

• UART signal inversion option

• +3.3V (using external oscillator) to +5.25V (internal oscillator) single supply operation

• Low-operating and USB suspend current

• Low USB bandwidth consumption

• UHCI/OHCI/EHCI host controller compatible

• USB 2.0 full speed compatible

ADF7xxx Wireless Transceiver Daughterboard Interface
The ADF7xxx Wireless Transceiver daughterboard interface supports the ADF7023, ADF7024, ADF7242,
ADF7030 and ADF7030-1 wireless transceivers. These are low-power, high-performance, integrated radio transceiv-
ers supporting a wide range of modulation schemes and channel widths in the sub-GHz and 2.4 GHz frequency
ranges.

"For more information about Analog Devices Transceiver offerings please visit : http://www.analog.com/en/prod-
ucts/rf-microwave/integrated-transceivers-transmitters-receivers/low-power-rf-transceivers.html

Arduino Interface
The Arduino interface supports connecting with 3V shield boards, extending the evaluation system's capabilities.
The connectors provide power, ground, reset, ADC, TWI, UART and GPIO signals.

Expansion Interface 3
The Expansion Interface 3 (EI3) interface supports connecting with other EI3 daughterboards designed by Analog
Devices, extending the evaluation system's capabilities. The connectors provide power, ground, reset, ADC, PPI,
TWI, UART, SPORT, SMC and GPIO signals.

The expansion interface is architected to provide support for modularity with different expansion board types. These
types fall into several categories including audio, video, converter, and asynchronous memory.

More information about available extender boards can be found at: http://www.analog.com/en/design-center/land-
ing-pages/001/sharc-processors-software-and-tools.html

ADF7xxx Wireless Transceiver Daughterboard Interface
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3   Hardware Reference

This chapter describes the hardware design of the ADuCM4050 EZ-KIT .

System Architecture
The board's configuration is shown in the Block Diagram figure.
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Figure 3-1: Block Diagram

Hardware Reference

ADuCM4050 EZ-KIT ®Manual 3–1

http://www.ftdichip.com/Products/ICs/FT232R.htm
http://www.winbond.com/hq/enu/ProductAndSales/ProductLines/FlashMemory/SerialFlash/W25Q128FV.htm


This EZ-KIT is designed to demonstrate the ADuCM4050 processor’s capabilities. The board has a 26 MHz input
clock and runs at 52 MHz internally.

User I/O to the processor is provided in the form of two user pushbuttons and three LEDs.

Switches
This section describes operation of the switches. The switch locations are shown in the Switch Locations figure.

SW2 SW3

SW5

SW1

SW4

Figure 3-2: Switch Locations

Boot Mode Select ( SW1 )

The pushbutton switch determines the boot mode of the processor. The Boot Mode Select Switch table shows the
available boot mode settings. By default, the processor boots from the internal flash memory. To get in Boot mode
0, user must hold down pushbutton during power-up.

Switches
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Table 3-1: Boot Mode Select Switch

Position Processor Boot Mode

0 UART download mode

1 Flash boot. Boot from integrated flash memory.

Reset Pushbutton ( SW2 )

The reset pushbutton resets the ADuCM4050 processor. The reset signal also is connected to the expansion connec-
tors via the SYS_HWRST signal. Reset ( LED1 ) is used to indicate when the board is in reset.

Wake Pushbutton ( SW3 )

The wake pushbutton is connected to the processor’s WAKE signal, based on the setting of Wake Select ( JP10 ).

GPIO Pushbuttons ( SW4-5 )

The GPIO pushbuttons are connected to the processor’s signals as follows:

Push Button ADuCM4050 LFCSP EZ-KIT ADuCm4050 WLCSP EZ-KIT

PB1 P2_09/GPIO41/ADC0_VIN6/
SPI0_CS3

P2_09/GPIO41/ADC0_VIN6/
SPI0_CS3

PB2 P2_06/GPIO38/ADC0_VIN3 P2_06/GPIO38/ADC0_VIN3

Jumpers
This section describes functionality of the configuration jumpers. The Jumper Locations figure shows the jumper
locations.

Switches
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Figure 3-3: Jumper Locations for ADuCM4050 WLCSP EZ-KIT
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Figure 3-4: Jumper Locations for ADuCM4050 LFCSP EZ-KIT

Main Power Select ( JP12 )

The main power select jumper selects whether the main power source for the board is provided from the emulator
interface, USB, or wall transformer. Refer to the Main Power Select Jumper table. The default setting is to power the
board from the USB cable.

Table 3-2: Main Power Select Jumper

Position Power Source

1 and 3 Emulator 5V

3 and 4 USB 5V

3 and 5 Wall 5V

Jumpers
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IO Power Select ( JP14 )

The IO power select jumper selects whether the IO power source for the board is provided from the on-board 3V
regulator, coin battery, or PV cell battery. Refer to the IO Power Select Jumper table. The default setting is to power
the IO from the on-board regulator.

Table 3-3: IO Power Select Jumper

Position Power Source

1 and 3 on-board regulator

3 and 4 coin battery

3 and 5 PV cell

ADXL363 Power Enable ( JP6 )

The ADXL363 power enable jumper allows the part to be connected or disconnected from the IO power rail. When
the jumper is installed, the device is connected to power. When the jumper is removed, power is disconnected from
the device. The device can be removed from the power rail to yield more accurate current measurements of the IO
rail when the device is not needed. The default is for the jumper to be installed.

W25Q32 Power Enable ( JP4 )

The W25Q32 power enable jumper allows the part to be connected or disconnected from the IO power rail. When
the jumper is installed, the device is connected to power. When the jumper is removed, power is disconnected from
the device. The device can be removed from the power rail to yield more accurate current measurements of the IO
rail when the device is not needed. The default is for the jumper to be installed.

ADT7420 Power Enable ( JP5 )

The ADT7420 power enable jumper allows the part to be connected or disconnected from the IO power rail. When
the jumper is installed, the device is connected to power. When the jumper is removed, power is disconnected from
the device. The device can be removed from the power rail to yield more accurate current measurements of the IO
rail when the device is not needed. The default is for the jumper to be installed.

Current Measurement ( JP1-3,JP15 )

The current measurement jumper JP15 is used to measure the current draw of the processor and 3V IO power rail.
The default is for both jumpers to be installed. To measure the current draw of the processor, remove the jumper
from pins 1 and 3 and insert an ammeter in series. In order to measure the current draw on the 3V IO rail remove
the jumper from pins 2 and 4 and insert an ammeter in series.

JP1, JP2 and JP3 will measure current of internal peripheral blocks of processor. All 3 jumpers will be installed by
default. To measure current draw of ADC peripheral block, remove jumper JP1 and measure voltage across R19. To
measure current draw of analog peripheral block, remove jumper JP2 and measure voltage across R20. To measure
current draw of digital peripheral block, remove jumper JP3 and measure voltage across R21.

Jumpers
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Remote Boot Select ( JP7 )

The remote boot select jumper allows the SYS_BMODE0 to be controlled by the FT232 when the jumper is instal-
led. The default is for the jumper not to be installed.

Remote Reset ( JP8 )

The remote reset jumper allows the SYS_HWRST to be controlled by the FT232 when the jumper is installed. The
default is for the jumper not to be installed.

Wake Select ( JP10 )

The Wake Select jumper is used to determine which WAKE signal from the processor is connected to the Wake
Pushbutton ( SW3 ); see the Wake Jumpers table. The default setting is on pins 1 and 2.

Table 3-4: Wake Jumpers

Setting Signal

1 and 2 SYS_WAKE0

3 and 4 SYS_WAKE1
5 and 6 SYS_WAKE2
7 and 8 SYS_WAKE3

ADC VREF Select ( JP17 )

The ADC VREF select jumper it used to connect the ADC voltage reference of the processor to external voltage
reference ICs either the ADR441 or the ADR127 device. When the jumper is placed on pins 1 and 2, the reference
is connected to the ADR441, which is a ultra low noise, LDO XFET voltage reference with current sink and source.
When the jumper is placed on pins 2 and 3, the reference is connected to the ADR127, which is a precision micro-
power LDO voltage reference. By default the jumper is connected to pins 2 and 3.

CAUTION: If the Internal Voltage Reference for ADC will be used via coding, remove the jumper from JP17 .

Battery Select ( JP16 )

The battery select jumper is used to choose between powering the board with a coin battery or a AA battery. When
the jumper is installed on pins 1 and 2, the coin cell battery is selected. When the jumper is installed on pins 2 and
3, the AA battery is selected. By default, the jumper is only connected to pin 1 - neither battery is connected.

RF Power Select ( JP11 )

The RF power select jumper will connect theEZ-KIT 3V supply to the Wireless Transreceiver daughter card. Pin1
and Pin2 will be shorted by default. If a Wireless Transreceiver daughterboard is used and will have it's own power
supply then Jumper between Pin1& Pin2 should be kept Open.

Jumpers
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Power Source Select ( JP13 )

The power source select jumper defines input voltage for processor and peripheral. Jumper is installed by default for
3V supply. Power supply will be 3.3V incase of open jumper.

mbed Power Enable ( JP18 )

The mbed power enable jumper allows the part to be connected or disconnected from the IO power rail. When the
jumper is installed, the mbed processor is connected to power. When the jumper is removed, power is disconnected
from the mbed processor. The mbed processor can be removed from the power rail to yield more accurate current
measurements of the IO rail when the mbed functionality is not needed. The default is for the jumper to be instal-
led. Jumper must be installed when mbed USB is connected to PC.

RF Config Select ( JP19 )

The RF config select jumper will configure different RF modules for communication. By default, the Jumper will
not be installed to provide connection for TMR0_2 and TMR0_3 to RGB LED. Jumper should be installed only
when ADF7xxx wireless module will be inserted on EZ-KIT.

LEDs
This section describes the on-board LEDs. The LED Locations figure shows the LED locations.

Jumpers
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Figure 3-5: LED Locations for ADuCM4050 WLCSP EZ-KIT
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Figure 3-6: LED Locations for ADuCM4050 LFCSP EZ-KIT

Reset ( LED1 )

When ON (red), it indicates that the board is in reset. A master reset is asserted by pressing SW2 , which activates
the LED. For more information, see Reset Pushbutton ( SW2 ).

Power ( LED2 )

When ON (green), it indicates that power is being supplied to the board properly.

GPIO ( LED3-5 )

Three LEDs are connected to the general-purpose I/O pins of the processor (see the GPIO LEDs table). The LEDs
are active high and are ON (amber) by writing a 1 to the correct processor signal.

LEDs
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Table 3-5: GPIO LEDs

LED Reference Designator Processor Programmable Flag Pin

LED3 P0_13
LED4 P1_12
LED5 P1_13

RGB ( LED6 )

RGB LED is enabled by Jumper JP9 .  By default jumper is installed on board.

RGB LED is connected to RGB PWM timer 1, 2 and 3 of processor.  LED will change color with different combi-
nation of PWM cycle for Timer out pins.

RGB LED Ref Designator LED Element Processor Programmable Pin

LED6 Red P1_06/GPIO22/SPI1_CLK/
RGB_TMR0_1

Green P1_07/GPIO23/SPI1_MOSI/
RGB_TMR0_2

Blue P1_08/GPIO24/SPI1_MISO/
RGB_TMR0_3

mbed ( LED7 )

When ON (amber), it indicates that mbed CPU is out of reset state. Connection between host PC and mbed USB
connector (P11) enables mbed CPU and activates mbed LED.

Connectors
This section describes connector functionality and provides information about mating connectors. The connector
locations are shown in the Connector Locations figure.

LEDs
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Figure 3-7: Connector Locations for ADuCM4050 WLCSP EZ-KIT
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Figure 3-8: Connector Locations for ADuCM4050 LFCSP EZ-KIT

NOTE: Connectors on the back of the board are noted with dotted lines.

Expansion Interface 3 ( P1A )

One board-to-board connector provides signals from the SPI, TWI, UART, SPORT, and GPIO interfaces of the
processor. This connector is located on the bottom side of the board. The connector expands the board's capabilities
by providing an interface to EI3 daughterboards.

Part Description Manufacturer Part Number

120-pin 0.6mm Hirose FX8-120P-SV1(91)

Mating Connector

120-pin 0.6mm Hirose FX8-120S-SV(21)

Connectors
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ADF7xxx Wireless Transceiver Daughterboard Interface ( P1-3 )

ADF7xxx wireless transceiver daughterboard interface connectors are listed in the following tables.

Table 3-6: P1 and P2 Connectors

Part Description Manufacturer Part Number

10-pin 0.05" terminal strip Samtec TFM-105-02-S-D-A

Mating Connector

10-pin 0.05" socket strip Samtec SFM-105-02-L-D-A

Table 3-7:  P3 Connectors

Part Description Manufacturer Part Number

20-pin 0.05" terminal strip Samtec TFM-110-02-S-D-A

Mating Connector

20-pin 0.05" socket strip Samtec SFM-110-02-L-D-A

Debug ( P4-5 )

The debug connectors provide a connection point for the emualtor to interface with the processor. There are two
debug connectors on the board. The P4 connector is a 0.1” 20 pin connector. The P5 connector is a 0.05" 10 pin
connector. For more information, see Debug Interface.

USB ( P6 )

The USB connector provides an interface between the EZ-KIT and a host PC via the USB to UART (FT232R).

Part Description Manufacturer Part Number

USB mini-B Hirose UX60SC-MB-5S8

UART ( P7 )

The UART connectors provides a connection point for external interface with the processor UART1 port.
UART1_Tx and UART1_Rx are direct signals from processor. The P7 connector is a 0.1” 4 pin male header. UART
interface GPIO details are as follows:

UART Signal (P7) ADuCM4050 LFCSP EZ-KIT ADuCM4050 WLCSP EZ-KIT

UART1_Tx (P7-2) P1_15/GPIO31/SPT0_ACLK/
UART1_TX

P2_12/GPIO44/UART1_TX/
SPI2_CS3

UART1_Rx (P7-3) P2_00/GPIO32/SPT0_AFS/
UART1_RX

P2_13/GPIO45/UART1_RX/
SPI0_CS2

Connectors
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Power ( P8 )

The power connector provides power to the board when the jumper of Main Power Select ( JP12 ) is placed on
pins 3 and 5.

Part Description Manufacturer Part Number

0.65 mm power jack CUI 045-0883R

Mating Connector

5.0VDC@3.6A power supplier GLOBETEK GS-1750(R)

ADF7xxx Wireless Transceiver Daughterboard Debug ( P9 )

The Debug connectors provides a debug option for ADF7xxx daughter board processor. The P9 connector is a
0.05" 10 pin connector.

mbed DEBUG ( P10 )

The mbed DEBUG connector provides debugging and programming option for mbed processor. mbed processor
can be programmed on board for future updates from mbed community. The P10 connector is a 0.05" 10 pin con-
nector.

mbed USB ( P11 )

The USB connector provides an interface between the EZ-KIT and a host PC via the mbed processor.

Part Description Manufacturer Part Number

USB mini-B Hirose UX60SC-MB-5S8

Battery ( J8 and J9 )

A battery can be used to power the board by setting the IO Power Select ( JP14 ).

Table 3-8: J8 Connector

Part Description Manufacturer Part Number

Coincell Holder MPD BS-3

Battery

3V 20mm Coin Panasonic CR2032

Table 3-9: J9 Connector

Part Description Manufacturer Part Number

AA Holder Keystone Electronics 2460

Connectors
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Table 3-9: J9 Connector (Continued)

Part Description Manufacturer Part Number

Battery

3.6V 2.6Ah AA Dantona Industries LS14500

PV Cell ( J3 )

This connector is used for interfacing with engery harvesting evaluation boards from Analog Devices.

Part Description Manufacturer Part Number

8-pin 0.1" right angle Harwin M20-7880446

Clock ( J1-2 )

The clock connectors allow for a connection point to the SYS_CLKIN and SYS_CLKOUT signals on the process-
or.

Part Description Manufacturer Part Number

SMC 75 ohms Amphenol 152119-75

Mating Cable

SMC cable Pasternack PE33154LF-12

Arduino Interface ( J4-7 )

The connectors for the Arduino interface are listed in the following tables.

Table 3-10: J4-J6 Connectors

Part Description Manufacturer Part Number

8-pin 0.1" socket strip Samtec SSW-108-01-TM-S

Mating Connector

8-pin .1" terminal strip Samtec TSW-108-07-T-S

Table 3-11: J7 Connector

Part Description Manufacturer Part Number

10-pin 0.1" socket strip Samtec SSW-110-01-TM-S

Mating Connector

10-pin .1" terminal strip Samtec TSW-110-07-T-S

Connectors
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